


View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.

Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Catalog, such as Edit Prod.    A check mark appears next to the 
menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse to some of the functions available in Catalog,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Display details of the supplier.

View delivery options and cost

Print the current order

Initiate context sensitive help.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the Catalog window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple document windows to display different parts or views of a document at 
the same time.    If you change the contents in one window, all other windows containing the 
same document reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Context Help command 

Use the Context Help command to obtain help on some portion of Catalog.    When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.    Then click somewhere in the Catalog window, such as another Toolbar 
button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

<< Show your application's title bar here. >>

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.

<< Describe the actions of the various parts of the scrollbar, according to how they behave 
in your application. >>



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Catalog window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the
title bar.

Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the
document Control menu closes only one window at a time.    You can close all windows at 
once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for the 
Invalid Filename message box. >>





Print command (File menu)

Use this command to print the order/quote.      This command presents a Print dialog box, 
where you may specify the range of pages to be printed, the number of copies, the 
destination printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that Order is sending output to the printer.   
The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the order/quote as it would appear when printed.    When you 
choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Order Help Index

Menu Commands
File menu
Edit menu
Order menu
View menu
Help menu



File menu commands

The file menu offers the following commands -

Open Catalog Open a catalog 
Print Prints a document.
Print Preview Displays the document on the screen as it would appear printed.
Print Setup Selects a printer and printer connection.
Exit Exits Catalog

Open catalog (File menu)

Use this command to open a catalog file using the Open Catalog Dialog Box .

Shortcuts
Keys: CTRL+O



Catalog Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename of the catalog file you wish to open.    This box lists files with 
the extension you select in the List Files of Type box. 

List Files of Type
The usual extension for a Catalog file is 'cat'.

Drives
Select the drive where the catalog file that you want to use resides. 

Directories
Select the directory where the catalog file that you want to use resides.



Edit menu commands

The file menu offers the following command -

Copy Copies the current supplier & order details to the clipboard



Quote/Order Options dialog box

The dialog box allows you to modify what will appear on the printed quote/order. 

Quote Header Text
These eight lines will be printed in a special box at the top left corner of your quote/order
print. They can be used to put any details you wish, such as names, addresses, purchase 
order numbers, tax exemption numbers, etc. These details are rembered by the program 
after you have exited.

Note : The maximum number of characters for each line is 40, but depending on 
your printer, long lines may not fit into the area provided. Using lower case as 
much as possible can help the situation.

The following options apply to delivery information -
Amend

Open the Delivery Options Dialog Box to amend the delivery information.

Include delivery cost on Quote/Order
If selected (a cross in the check box) then delivery details will be printed.



Order menu commands

The Order menu offers the following commands -

Supplier Details Display the details of the supplier of the current catalog.. 
Delivery Options Calculate delivery cost for the current order.
Product Add the current product to the order.
Get Product Get a product by its code to add to the order.
Options Display the Options dialog box
Clear Ordered 
Items

Remove all items from the ordered items area.

Supplier Details (Order menu)

The dialog box displayed shows details of the supplier of the current catalog, and it's expiry 
date (if there is one). 

Shortcuts

Toolbar:



Delivery Details (Order menu)

This option allows the calculation of the delivery cost using the Delivery Dialog

Shortcuts

Toolbar:



Delivery dialog box

This option allows the calculation of the delivery cost. A number of methods may be 
available, such as air freight for urgent orders, as well as the suppliers standard method. In 
some cases, only some of the delivery methods will apply to you.

The following options allow you to specify which delivery schedule to wish to calculate the 
cost of :

Delivery method
A drop down list box enables you to select an appropriate delivery method. 

Selections
Some delivery methods require extra information to determine the cost. If the method 
(above) is such a case, then you should make a suitable selection here.

Note : this dialog box is displayed before printing the order/quote if delivery schedules 
have been included in the catalog. If you do not wish to include delivery information on 
the quote, press the escape key or click the mouse on cancel when this dialog box 
appears for printing.



Product (Order menu)

This command allows you to add the current product to the order, or amend the quantity 
ordered if it is already included in the order.

This is done in the Order Product dialog box.

Shortcut
Keys: enter key    when a product is highlighted

Mouse: double click the mouse (left button) on the desired product



Get product (Order menu)

This allows the selection of a product directly by its code, without having to highlight the 
product in the product window.

Shortcut : Ctrl + G

The dialog displayed requires the following information -

Code the code of the product 

The Order Product dialog box is then displayed so the product can be included in the order.



Order Product dialog box

The dialog displays details about the product you have selected, including weight, and price 
information.

Notes
This button will be visible if there are additional notes for the current product. (The short 
cut key is ALT-N.)

quantity required
To include the product in the order/quote, a quantity must be entered. If a product has 
been included but you wish to remove it from the order/quote, set the quantity to zero.



Product Notes dialog box

Extra notes about the product are displayed here. 



Options (Order menu)

This command allows you to tailor the information displayed in a number of ways.

This is done in the Options dialog box.



Options dialog box

The following options are available :

Tax
You may specify the tax calculated and displayed on the order. Wholesale style Catalogs 
can supply their own tax Default types, retail Catalogs do not specify a tax rate. If you 
wish to specify and use a tax rate (e.g. VAT, GST) then select Alternate. If you do not 
wish to include tax on an order, then check the Exclude option.

Alternate Tax
If you have checked the Alternate Tax option, you can specify the rate (as a percentage) 
and the type (name) of the tax (e.g. VAT). 

Currency Conversion
This allows all prices to be displayed in an alternate currency. The conversion rates must 
be entered, and the Use alternate currency check box checked. All price information 
displayed (including the printout) will be in the alternate currency.



Clear Ordered Items

This removes all the items included in the current order, and sets the cost/tax/weight totals 
to zero. Use this to create a new order.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Catalog and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
Catalog.



Exit command (File menu)

Use this command to end your Order session.    You can also use the Close command on the 
application Control menu.    

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Password dialog

If the Catalog file you wish to use has a password, you must it enter the password here in 
order to view the Catalog file.    

Note : alphabetic characters are case sensitive i.e. 'D' is different to 'd'.



active category

indicates which is the active category .
Note : if the product display is 'All Products' or 'Orphans', there is no active category.



distribution catalog
The file produced by the create catalog option, which is used to create quotes/orders from 
your product range. It includes taxes and delivery charges to provide the complete cost.






